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[bookmark: section_b7eb110b1be44195bce514f5b27a0ed0][bookmark: _Toc79583800]Introduction
The 3-D Map Data Tour file format is used to display an interactive 3-D visualization of data over a map. The visualization can contain multiple parts which focus on one or multiple places on the map and depict different time scales and the events associated with the data. 
Sections 1.7 and 2 of this specification are normative. All other sections and examples in this specification are informative.
[bookmark: section_3ab67c0ca1ba474b9cbbf2ebf03a6184][bookmark: _Toc79583801]Glossary
This document uses the following terms:
[bookmark: gt_42d624c5-6002-4375-b1b0-f7f4eee0c07d]animation: A record of synthetic, successive still images that produce an illusion of movement when played back.
[bookmark: gt_24fe14f8-a7a4-4e18-a9f6-21b032d3359b]camera: A virtual representation of a camera that controls the position of the viewer window inside the 3-D environment.
[bookmark: gt_cf31915d-9d25-4dbb-abc7-e78f60626dc4]data point: An individual value that is plotted in a chart and is represented together with other data points by bars, columns, lines, pie or doughnut slices, dots, and various other shapes, which are referred to as data markers. Data markers of the same color constitute a data series.  
[bookmark: gt_0606f1a0-e611-41b2-9974-3ab80114f03c]effect: A user-specified camera motion that occurs for the duration of a scene.
[bookmark: gt_4efdfb97-9fb8-46b7-b8cf-e5f92402add6]scene: An independent part of a tour that has a beginning and end, and a specific time duration in which a particular data visualization on the map occurs. 
[bookmark: gt_8b5eb4c0-949b-47d9-8b63-b9bda81d61b8]theme: A set of unified design elements, such as colors, fonts, graphics, and styles, that define the appearance of a website, document, or data visualization. 
[bookmark: gt_84d44447-feaf-41a4-bf12-004c0f080fc2]tooltip: A window displaying text that is created when the mouse is moved over a window or notification icon.
[bookmark: gt_5e1378a9-7181-4a4d-8b80-85c235267618]tour: A scene or sequence of scenes that describe a story about geographical locations, time periods, and data visualization.
[bookmark: gt_c91f6339-cef5-4254-bb6a-f048c5d86541]transition: The camera path and time period that connects one scene to another.
[bookmark: gt_343c4660-90e1-4d86-b9cc-5007075d9dfe]workbook: A container for a collection of sheets.
[bookmark: gt_982b7f8e-d516-4fd5-8d5e-1a836081ed85]XML: The Extensible Markup Language, as described in [XML1.0].
[bookmark: gt_bd0ce6f9-c350-4900-827e-951265294067]XML schema: A description of a type of XML document that is typically expressed in terms of constraints on the structure and content of documents of that type, in addition to the basic syntax constraints that are imposed by XML itself. An XML schema provides a view of a document type at a relatively high level of abstraction.
MAY, SHOULD, MUST, SHOULD NOT, MUST NOT: These terms (in all caps) are used as defined in [RFC2119]. All statements of optional behavior use either MAY, SHOULD, or SHOULD NOT.
[bookmark: section_01f90074c554402a9b492a6b0641394e][bookmark: _Toc79583802]References
Links to a document in the Microsoft Open Specifications library point to the correct section in the most recently published version of the referenced document. However, because individual documents in the library are not updated at the same time, the section numbers in the documents may not match. You can confirm the correct section numbering by checking the Errata.  
[bookmark: section_313409db150146459441b0ed0da3f2d7][bookmark: _Toc79583803]Normative References
We conduct frequent surveys of the normative references to assure their continued availability. If you have any issue with finding a normative reference, please contact dochelp@microsoft.com. We will assist you in finding the relevant information. 
[RFC2119] Bradner, S., "Key words for use in RFCs to Indicate Requirement Levels", BCP 14, RFC 2119, March 1997, http://www.rfc-editor.org/rfc/rfc2119.txt
[XMLSCHEMA1/2] Thompson, H., Beech, D., Maloney, M., and Mendelsohn, N., Eds., "XML Schema Part 1: Structures Second Edition", W3C Recommendation, October 2004, http://www.w3.org/TR/2004/REC-xmlschema-1-20041028/
[XMLSCHEMA2/2] Biron, P., and Malhotra, A., Eds., "XML Schema Part 2: Datatypes Second Edition", W3C Recommendation, October 2004, http://www.w3.org/TR/2004/REC-xmlschema-2-20041028/
[bookmark: section_38d3da3d54ea4b5a942d9d92fc55d80b][bookmark: _Toc79583804]Informative References
None.
[bookmark: section_cd6e7d0d29574d23a6f5c8f714ac9e73][bookmark: _Toc79583805]Overview
This structure allows the exploration and visualization of data on a map, which can be a flat 3-D surface or a 3-D globe. This structure allows for animating over time and visualization of historical trends of the data over time. This structure also allows for various levels of visualization using 2-D visuals which can be anchored to the top level of the 3D environment. These 2-D visuals can be text boxes or flat 2-D charts that provide more insights into the data. This structure is capable of displaying multiple layers of data and users can change specific visual properties of the extrusions representing the accumulated data on the globe. It is also possible to animate the data using different aggregation options over time, or partition the animation over common units of time – such as days, weeks, or months. This structure supports annotations that are anchored to data extrusions, and the annotations can contain custom text and/or generic ToolTips which are derived from the data. This structure can support different styles of data shapes and visual map themes, and different chart types, such as heat maps or pie charts which appear as data extrusions in the data. The structure supports sequencing of different parts which are called scenes; a specific sequence of these scenes is called a tour. Each scene has a specific motion to it, called a transition, as well as motion which is an option for the duration of the scene, called an effect.
[bookmark: section_027f7eb728684280af06d03bc687d2a7][bookmark: _Toc79583806]Relationship to Protocols and Other Structures
This structure depends on geocoding and mapping services. These are public and can be provided from a variety of vendors. This structure also depends on data query APIs for data rendering in the 3-D environment.   
[bookmark: section_00ef937c066243798f35b85a533b5939][bookmark: _Toc79583807]Applicability Statement
This structure should be used when an application renders a 3-D geospatial data collection of scenes which collectively describe a story about data on a map inside a 3-D mapped environment. 
[bookmark: section_07484a3c54dc4b70b983975a8e5dc2a3][bookmark: _Toc79583808]Versioning and Localization
Structure Versions: This structure specifies the only version of the 3-D Map Data Tour file format.
· Localization: The file format allows one or more of the following elements to be stored in their localized form.
· Workbook column names
· Tour name
· Scene name
· Layer name
· Text box content
· Annotation content
· Date and time format
[bookmark: section_49891e2d226b49c79088d44c3ffd8d0b][bookmark: _Toc79583809]Vendor-Extensible Fields
None.
[bookmark: section_687d942f4ec142db803815e41f9634e6][bookmark: _Toc79583810]Structures
[bookmark: section_f214645826dc4c2a9991e53041230cf5][bookmark: _Toc79583811]Complex Types
[bookmark: section_558adfe90ef24693902a12cdf8f8d611][bookmark: _Toc79583812]CT_Camera
Target namespace: http://microsoft.data.visualization.engine.tours/1.0
Referenced by: CT_Frame
[bookmark: CC_ae407454000000000000000000000000] Specifies the position of the camera in the initial frame of a scene.
Child Elements:
[bookmark: CC_3d547cbd000000000000000000000000]Latitude: An xs:decimal ([XMLSCHEMA2/2] section 3.2.3) element that specifies the latitude of the camera target in degrees.
[bookmark: CC_2fa2b30d000000000000000000000000]Longitude: An xs:decimal ([XMLSCHEMA2/2] section 3.2.3) element that specifies the longitude of the camera target in degrees.
[bookmark: CC_659bc61e000000000000000000000000]Rotation: An xs:decimal ([XMLSCHEMA2/2] section 3.2.3) element that specifies the rotation angle of the camera in radians. This value is zero when the camera is pointing north.
[bookmark: CC_304547af000000000000000000000000]PivotAngle: An xs:decimal ([XMLSCHEMA2/2] section 3.2.3) element that specifies the vertical angle between a tangential plane at the target point and the line drawn from the target to the camera.
[bookmark: CC_5a1f2c80000000000000000000000000]Distance: An xs:decimal ([XMLSCHEMA2/2] section 3.2.3) element that specifies the normalized camera distance to the target position. A distance of 1.0 equals the radius of the earth.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this complex type.
<xsd:complexType name="CT_Camera">
  <xsd:sequence>
    <xsd:element name="Latitude" type="xsd:decimal"/>
    <xsd:element name="Longitude" type="xsd:decimal"/>
    <xsd:element name="Rotation" type="xsd:decimal"/>
    <xsd:element name="PivotAngle" type="xsd:decimal"/>
    <xsd:element name="Distance" type="xsd:decimal"/>
  </xsd:sequence>
</xsd:complexType>
See section 5.1 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_d90c241e2fe64be7a8fcc0173859feee][bookmark: _Toc79583813]CT_CustomMapList
Target namespace: http://microsoft.data.visualization.Client.Excel.CustomMapList/1.0
Referenced by: CustomMapList
[bookmark: CC_728cc02d000000000000000000000000] Specifies the custom maps stored in a workbook.
Child Elements:
[bookmark: CC_c1146d8f000000000000000000000000]ml: A xs:string ([XMLSCHEMA2/2] section 3.2.1) element that specifies the image for a custom map.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this complex type.
<xsd:complexType name="CT_CustomMapList">
  <xsd:sequence>
    <xsd:element name="ml" type="xsd:string"/>
  </xsd:sequence>
</xsd:complexType>
See section 5.6 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_890bbca8d5c94440a134e51e768fcaaa][bookmark: _Toc79583814]CT_CustomRegionState
Target namespace: http://microsoft.data.visualization.Client.Excel.CustomRegionState/1.0
Referenced by: CustomRegionState
[bookmark: CC_f93cdcb3000000000000000000000000] Specifies the custom regions stored in a workbook.
Child Elements:
[bookmark: CC_615f74b6000000000000000000000000]rl: A xs:string ([XMLSCHEMA2/2] section 3.2.1) element that specifies the compressed contents of a set of custom regions.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this complex type.
<xsd:complexType name="CT_CustomRegionState">
  <xsd:sequence>
    <xsd:element name="rl" type="xsd:string"/>
  </xsd:sequence>
</xsd:complexType>
See section 5.5 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_1694523fbbfa442487c5067fdcda1e08][bookmark: _Toc79583815]CT_Frame
Target namespace: http://microsoft.data.visualization.engine.tours/1.0
Referenced by: CT_Scene
[bookmark: CC_22b99ce6000000000000000000000000]Specifies the initial frame of a scene.
Child Elements:
[bookmark: CC_5460e1eb000000000000000000000000]Camera: A CT_Camera (section 2.1.1) element that specifies the parameters of the camera in its initial position in the frame.
[bookmark: CC_cc7e68f2000000000000000000000000]Image: A xs:string ([XMLSCHEMA2/2] section 3.2.1) element that specifies the image for the frame.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this complex type.
<xsd:complexType name="CT_Frame">
  <xsd:sequence>
    <xsd:element name="Camera" type="tns:CT_Camera"/>
    <xsd:element name="Image" type="xsd:string"/>
  </xsd:sequence>
</xsd:complexType>
See section 5.1 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_04590645a6354d7f874226dca3b3b201][bookmark: _Toc79583816]CT_Scene
Target namespace: http://microsoft.data.visualization.engine.tours/1.0
Referenced by: CT_Scenes
[bookmark: CC_2bf55851000000000000000000000000]Specifies a scene in the tour.
Child Elements:
[bookmark: CC_55853580000000000000000000000000]Transition: An xs:string ([XMLSCHEMA2/2] section 3.2.1) element that specifies the type of camera transition for this scene. Can only be set to "MoveTo".
[bookmark: CC_0f332f1c000000000000000000000000]Effect: An xs:string ([XMLSCHEMA2/2] section 3.2.1) element that specifies the camera motion effect. Possible values are "Station", "Circle", "Dolly", "FlyOver", "PushIn", "Figure8" and "RotateGlobe".
[bookmark: CC_0ddca5a2000000000000000000000000]Theme: An xs:string ([XMLSCHEMA2/2] section 3.2.1) element that specifies the type of theme applied to this scene. Possible values are "BingRoad", "BingRoadHighContrast", "Aerial", "Grey", "Dark", "Light", "Mono", "White", "Earthy", "Modern", "Organic", and "Radiate".
[bookmark: CC_2c8e79fc000000000000000000000000]ThemeWithLabel: An xs:boolean ([XMLSCHEMA2/2] section 3.2.2) element that specifies whether a theme with labels enabled has been applied to this scene. A value of 1 indicates that a theme with labels enabled has been applied to this scene; a value of 0 indicates that a theme with labels enabled has not been applied to this scene.
[bookmark: CC_e54b062f000000000000000000000000]FlatModeEnabled: An xs:boolean ([XMLSCHEMA2/2] section 3.2.2) element that specifies whether the scene has a 3-D map represented as a globe. A value of 1 indicates that the map is represented in as a globe; a value of 0 indicates that the map is represented as a flat surface. 
[bookmark: CC_d58f7294000000000000000000000000]Duration: An xs:unsignedInt ([XMLSCHEMA2/2] section 3.3.22) element that specifies the scene duration in 100-nanosecond units.
[bookmark: CC_515d497b000000000000000000000000]TransitionDuration: An xs:unsignedInt ([XMLSCHEMA2/2] section 3.3.22) element that specifies the duration of the scene transition in 100-nanosecond units.
[bookmark: CC_b3bca544000000000000000000000000]Speed: An xs:decimal ([XMLSCHEMA2/2] section 3.2.3) element that specifies the relative speed of the scene effect. Possible values lie between 0 and 1.
[bookmark: CC_99407584000000000000000000000000]Frame: A CT_Frame (section 2.1.4) element that specifies the first frame of this scene in the 3D Map tour.
[bookmark: CC_b8f2391e000000000000000000000000]LayersContent: An xs:string ([XMLSCHEMA2/2] section 3.2.1) element that specifies the contents of a scene in the tour.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this complex type.
<xsd:complexType name="CT_Scene">
  <xsd:sequence>
    <xsd:element name="Transition" type="xsd:string"/>
    <xsd:element name="Effect" type="xsd:string"/>
    <xsd:element name="Theme" type="xsd:string"/>
    <xsd:element name="ThemeWithLabel" type="xsd:boolean"/>
    <xsd:element name="FlatModeEnabled" type="xsd:boolean"/>
    <xsd:element name="Duration" type="xsd:unsignedInt"/>
    <xsd:element name="TransitionDuration" type="xsd:unsignedInt"/>
    <xsd:element name="Speed" type="xsd:decimal"/>
    <xsd:element name="Frame" type="tns:CT_Frame"/>
    <xsd:element name="LayersContent" type="xsd:string"/>
  </xsd:sequence>
</xsd:complexType>
See section 5.1 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_4aab1e433ff14911b53d12f1614bca88][bookmark: _Toc79583817]CT_Scenes
Target namespace: http://microsoft.data.visualization.engine.tours/1.0
Referenced by: CT_Tour
[bookmark: CC_80d5d108000000000000000000000000]Specifies the collection of scenes in the 3D Map tour. There is at least one scene per tour.
Child Elements:
[bookmark: CC_16500705000000000000000000000000]Scene: A CT_Scene (section 2.1.5) element that specifies a scene in a 3D Map tour.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this complex type.
<xsd:complexType name="CT_Scenes">
  <xsd:sequence>
    <xsd:element maxOccurs="unbounded" name="Scene" type="tns:CT_Scene"/>
  </xsd:sequence>
</xsd:complexType>
See section 5.1 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_1e72040b2fbb452cba66442323476a6c][bookmark: _Toc79583818]CT_Tour
Target namespace: http://microsoft.data.visualization.engine.tours/1.0
Referenced by: Tour
[bookmark: CC_8a19c55e000000000000000000000000]Specifies a tour comprised of one or more scenes in a 3D Map.
Child Elements:
[bookmark: CC_a5e37a4b000000000000000000000000]Scenes: A CT_Scenes (section 2.1.6) element that specifies a collection of scenes within the tour.
Attributes:
[bookmark: CC_34db6455000000000000000000000000]Name: An xs:string ([XMLSCHEMA2/2] section 3.2.1) attribute that specifies the name of the tour.
[bookmark: CC_fd7abfff000000000000000000000000]Description: An xs:string ([XMLSCHEMA2/2] section 3.2.1) attribute that specifies the description of the tour.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this complex type.
<xsd:complexType name="CT_Tour">
  <xsd:sequence>
    <xsd:element name="Scenes" type="tns:CT_Scenes"/>
  </xsd:sequence>
  <xsd:attribute name="Name" type="xsd:string" use="required"/>
  <xsd:attribute name="Description" type="xsd:string" use="required"/>
</xsd:complexType>
See section 5.1 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_a593ec74aae64e668a2cdb65b719b32a][bookmark: _Toc79583819]CT_Tour
Target namespace: http://microsoft.data.visualization.Client.Excel/1.0
Referenced by: CT_Tours
[bookmark: CC_d1185e4a000000000000000000000000]Specifies a 3D Map tour.	
Child Elements:
[bookmark: CC_cdcf8e91000000000000000000000000]Description: An xs:string ([XMLSCHEMA2/2] section 3.2.1) element that specifies the description of the tour.
[bookmark: CC_9d49df86000000000000000000000000]Image: An xs:string ([XMLSCHEMA2/2] section 3.2.1) element that specifies the image that represents the tour.
Attributes:
[bookmark: CC_9b62ed05000000000000000000000000]Name: An xs:string ([XMLSCHEMA2/2] section 3.2.1) attribute that specifies the name of the tour.
[bookmark: CC_ad844d86000000000000000000000000]Id: An xs:string ([XMLSCHEMA2/2] section 3.2.1) attribute that specifies a unique identifier for the version of the tour.
[bookmark: CC_b06b3855000000000000000000000000]TourId: An xs:string ([XMLSCHEMA2/2] section 3.2.1) attribute that specifies a unique identifier for the tour.
[bookmark: CC_a7065378000000000000000000000000]XmlVer: An xs:unsignedByte ([XMLSCHEMA2/2] section 3.3.24) attribute that specifies the current version of the XML representation of the tour.
[bookmark: CC_6d684b0d000000000000000000000000]MinXmlVer: An xs:unsignedByte ([XMLSCHEMA2/2] section 3.3.24) attribute that specifies the minimum compatible XML version of the tour.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this complex type.
<xsd:complexType name="CT_Tour">
  <xsd:sequence>
    <xsd:element name="Description" type="xsd:string"/>
    <xsd:element name="Image" type="xsd:string"/>
  </xsd:sequence>
  <xsd:attribute name="Name" type="xsd:string" use="required"/>
  <xsd:attribute name="Id" type="xsd:string" use="required"/>
  <xsd:attribute name="TourId" type="xsd:string" use="required"/>
  <xsd:attribute name="XmlVer" type="xsd:unsignedByte" use="required"/>
  <xsd:attribute name="MinXmlVer" type="xsd:unsignedByte" use="required"/>
</xsd:complexType>
See section 5.4 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_0fdf142b44104ccb807db6c84a68089b][bookmark: _Toc79583820]CT_Tours
Target namespace: http://microsoft.data.visualization.Client.Excel/1.0
Referenced by: CT_Visualization
[bookmark: CC_5e64d2b7000000000000000000000000]Specifies the collection of tours contained within a workbook.
Child Elements:
[bookmark: CC_27b14b96000000000000000000000000]Tour: A CT_Tour (section 2.1.8) element that specifies a tour.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this complex type.
<xsd:complexType name="CT_Tours">
  <xsd:sequence>
    <xsd:element maxOccurs="unbounded" name="Tour" type="tns:CT_Tour"/>
  </xsd:sequence>
</xsd:complexType>
See section 5.4 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_dcbac17b457f45939f42cd480992ef98][bookmark: _Toc79583821]CT_Visualization
Target namespace: http://microsoft.data.visualization.Client.Excel/1.0
Referenced by: Visualization
[bookmark: CC_289bc8fd000000000000000000000000]Specifies the 3-D visualizations stored in a workbook.
Child Elements:
[bookmark: CC_ea5a67d1000000000000000000000000]Tours: A CT_Tours (section 2.1.9) element that specifies the collection of tours stored in the workbook.
[bookmark: CC_2eb3de64000000000000000000000000]Colors: An xs:anyType ([XMLSCHEMA1/2] section 3.4.7) element that specifies the custom color palette selected by the user for the visualizations.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this complex type.
<xsd:complexType name="CT_Visualization">
  <xsd:sequence>
    <xsd:element name="Tours" type="tns:CT_Tours"/>
    <xsd:element name="Colors"/>
  </xsd:sequence>
</xsd:complexType>
See section 5.4 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_011907413adb4bf683c599af883cb2eb][bookmark: _Toc79583822]CT_VisualizationLState
Target namespace: http://microsoft.data.visualization.Client.Excel.LState/1.0
Referenced by: VisualizationLState
[bookmark: CC_fccc5986000000000000000000000000]Specifies a container for geocoded data points within a 3D Map.
Child Elements:
[bookmark: CC_a96cbe2a000000000000000000000000]cg: An xs:string ([XMLSCHEMA2/2] section 3.2.1) element that specifies the geocoded data points.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this complex type.
<xsd:complexType name="CT_VisualizationLState">
  <xsd:sequence>
    <xsd:element name="cg" type="xsd:string"/>
  </xsd:sequence>
</xsd:complexType>
See section 5.2 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_d05e21bf63d747dd9c13ee9050f62ca4][bookmark: _Toc79583823]CT_VisualizationPState
Target namespace: http://microsoft.data.visualization.Client.Excel.PState/1.0
Referenced by: VisualizationPState
[bookmark: CC_12e2c2e0000000000000000000000000]Specifies the container for data used for mapping regions.
Child Elements:
[bookmark: CC_f04ad517000000000000000000000000]rp: An xs:string ([XMLSCHEMA2/2] section 3.2.1) element that specifies the region polygons.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this complex type.
<xsd:complexType name="CT_VisualizationPState">
  <xsd:sequence>
    <xsd:element name="rp" type="xsd:string"/>
  </xsd:sequence>
</xsd:complexType>
See section 5.3 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_b05f9981a2f948fa9ae1814131c51167][bookmark: _Toc79583824]Elements
[bookmark: section_efe04f9ea22844ca901b82c860a0540d][bookmark: _Toc79583825]CustomMapList
Target namespace: http://microsoft.data.visualization.Client.Excel.CustomMapList/1.0
[bookmark: CC_e2bdeeb8000000000000000000000000]A CT_CustomMapList element that specifies the custom maps stored in the workbook.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this element.
<xsd:element name="CustomMapList" type="tns:CT_CustomMapList"/>
See section 5.6 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_b31e583c1d7f4de69dee6aaf79a8acc5][bookmark: _Toc79583826]CustomRegionState
Target namespace: http://microsoft.data.visualization.Client.Excel.CustomRegionState/1.0
[bookmark: CC_beb98a4a000000000000000000000000]A CT_CustomRegionState element that specifies the custom regions stored in the workbook.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this element.
<xsd:element name="CustomRegionState" type="tns:CT_CustomRegionState"/>
See section 5.5 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_3b20e8d94cf24d9b8f42c7a4010ea89e][bookmark: _Toc79583827]Tour
Target namespace: http://microsoft.data.visualization.engine.tours/1.0
[bookmark: CC_53f8afb4000000000000000000000000]A CT_Tour (section 2.1.7) element that specifies a tour in a 3D Map.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this element.
<xsd:element name="Tour" type="tns:CT_Tour"/>
See section 5.1 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_07666ca0ae8347caa4854ad4def6017e][bookmark: _Toc79583828]Visualization
Target namespace: http://microsoft.data.visualization.Client.Excel/1.0
[bookmark: CC_88ada9c2000000000000000000000000]A CT_Visualization (section 2.1.10) element that specifies the 3-D visualizations stored in the workbook.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this element.
<xsd:element name="Visualization" type="tns:CT_Visualization"/>
See section 5.4 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_f46007d1caad41fd99b812eb302ee327][bookmark: _Toc79583829]VisualizationLState
Target namespace: http://microsoft.data.visualization.Client.Excel.LState/1.0
[bookmark: CC_55ec8e19000000000000000000000000]A CT_VisualizationLState (section 2.1.11) element that specifies a container for geocoded data points.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this element.
<xsd:element name="VisualizationLState" type="tns:CT_VisualizationLState"/>
See section 5.2 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_aa1a3d148b9a4500bd39281c16182dbc][bookmark: _Toc79583830]VisualizationPState
Target namespace: http://microsoft.data.visualization.Client.Excel.PState/1.0
[bookmark: CC_ea9352ee000000000000000000000000]A CT_VisualizationPState (section 2.1.12) element that specifies a container for data used for region mappings.
The following W3C XML Schema ([XMLSCHEMA1/2] section 2.1) fragment specifies the contents of this element.
<xsd:element name="VisualizationPState" type="tns:CT_VisualizationPState"/>
See section 5.3 for the full W3C XML Schema ([XMLSCHEMA1/2] section 2.1).
[bookmark: section_b7ff16dec14c4012aca1c773bfcf2e5c][bookmark: _Toc79583831]Structure Examples
The following is an example of the structure with a tour that has a single scene. 
<?xml version="1.0" encoding="UTF-16"?>
<Tour xmlns="http://microsoft.data.visualization.engine.tours/1.0" Description="Some description for the tour goes here" Name="Tour 1" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema"><Scenes><Scene><Transition>MoveTo</Transition><Effect>Station</Effect><Theme>White</Theme><ThemeWithLabel>false</ThemeWithLabel><FlatModeEnabled>false</FlatModeEnabled><Duration>60000000</Duration><TransitionDuration>30000000</TransitionDuration><Speed>0.5</Speed><Frame><Camera><Latitude>40.968825575557013</Latitude><Longitude>-111.36067867162427</Longitude><Rotation>0</Rotation><PivotAngle>-0.19670261929383437</PivotAngle><Distance>0.6</Distance></Camera><Image></Image></Frame><LayersContent><?xml version="1.0" encoding="utf-16"?><SerializedLayerManager xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" PlayFromIsNull="true" PlayFromTicks="0" PlayToIsNull="true" PlayToTicks="0" DataScale="NaN" DimnScale="NaN" xmlns="http://microsoft.data.visualization.geo3d/1.0"><LayerDefinitions><LayerDefinition Name="Layer 1" Guid="3f1c55e6-aee3-4d0e-b211-eb4903e561f2" Rev="5" RevGuid="4a3a0bb5-d2eb-43f6-a6f0-61328034fdfd" Visible="true" InstOnly="false" GeoDataGuid="dae80666-9362-4607-a2c6-511d76749d59"><GeoVis Visible="true" LayerColorSet="false" RegionShadingModeSet="false" RegionShadingMode="Global" VisualType="StackedColumnChart" Nulls="false" Zeros="true" Negatives="true" VisualShape="Square" LayerShapeSet="false" LayerShape="InvertedPyramid" HiddenMeasure="false"><LockedViewScales><LockedViewScale>NaN</LockedViewScale><LockedViewScale>NaN</LockedViewScale><LockedViewScale>NaN</LockedViewScale><LockedViewScale>NaN</LockedViewScale></LockedViewScales><LayerColor><R>0</R><G>0</G><B>0</B><A>0</A></LayerColor><ColorIndices><ColorIndex>0</ColorIndex><ColorIndex>1</ColorIndex><ColorIndex>2</ColorIndex><ColorIndex>3</ColorIndex></ColorIndices><GeoFieldWellDefinition Accumulate="false" Decay="None" DecayTimeIsNull="true" DecayTimeTicks="0" VMTimeAccumulate="false" VMTimePersist="false" UserNotMapBy="true" SelTimeStg="None" ChoosingGeoFields="false"><GeoEntity Name="GeoEntity" Visible="false"><GeoColumns><GeoColumn Name="City" Visible="true" DataType="String" ModelQueryName="'Table1'[City]"><Table ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" /></GeoColumn><GeoColumn Name="Country" Visible="true" DataType="String" ModelQueryName="'Table1'[Country]"><Table ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" /></GeoColumn></GeoColumns><Locality Name="City" Visible="true" DataType="String" ModelQueryName="'Table1'[City]"><Table ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" /></Locality><Country Name="Country" Visible="true" DataType="String" ModelQueryName="'Table1'[Country]"><Table ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" /></Country></GeoEntity><Measures><Measure Name="Cars" Visible="true" DataType="Long" ModelQueryName="'Table1'[Cars]"><Table ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" /></Measure></Measures><MeasureAFs><AggregationFunction>Sum</AggregationFunction></MeasureAFs><Category Name="Model" Visible="true" DataType="String" ModelQueryName="'Table1'[Model]"><Table ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" /></Category><ColorAF>None</ColorAF><ChosenFields /><ChunkBy>None</ChunkBy><ChosenGeoMappings><GeoMappingType>City</GeoMappingType><GeoMappingType>Country</GeoMappingType></ChosenGeoMappings></GeoFieldWellDefinition><Properties><InstanceProperty InstanceId="LatLatValLonLonValAddrAddrValAdAdValAd2Ad2ValCountry'Table1'[Country]CountryValUSALoc'Table1'[City]LocValSeattleZipZipValFullAddrFullAddrValOldOldValCat'Table1'[Model]CatValFordMsr'Table1'[Cars]MsrAFSumMsrValMsrCalcFnAnyMeasFALSEAnyCatValFALSE#"><Annotation><BackgroundColor><A>0</A><R>0</R><G>0</G><B>0</B><ScA>0</ScA><ScR>0</ScR><ScG>0</ScG><ScB>0</ScB></BackgroundColor><Title><FormatType>Static</FormatType><Text>These are cars in Seattle </Text><TextTemplate>{0}: {1}</TextTemplate><FontSize>16</FontSize><FontFamily>Segoe UI</FontFamily><FontStyle>Normal</FontStyle><FontWeight>Normal</FontWeight><Color><A>255</A><R>0</R><G>0</G><B>0</B><ScA>1</ScA><ScR>0</ScR><ScG>0</ScG><ScB>0</ScB></Color></Title><TitleField>City</TitleField><TitleAF xsi:nil="true" /><Description><FormatType>Static</FormatType><FontSize>12</FontSize><FontFamily>Segoe UI</FontFamily><FontStyle>Normal</FontStyle><FontWeight>Normal</FontWeight><Color><A>255</A><R>0</R><G>0</G><B>0</B><ScA>1</ScA><ScR>0</ScR><ScG>0</ScG><ScB>0</ScB></Color></Description><FieldFormat><FormatType>Template</FormatType><Text>Model: Ford</Text><TextTemplate>{0}: {1}</TextTemplate><FontSize>12</FontSize><FontFamily>Segoe UI</FontFamily><FontStyle>Normal</FontStyle><FontWeight>Normal</FontWeight><Color><A>255</A><R>0</R><G>0</G><B>0</B><ScA>1</ScA><ScR>0</ScR><ScG>0</ScG><ScB>0</ScB></Color></FieldFormat><DescriptionType>Bound</DescriptionType><ImageSize>Medium</ImageSize><NamesOfColumnsToDisplay><string>Cars</string><string>Model</string></NamesOfColumnsToDisplay><ColumnAggregationFunctions><AggregationFunction>Sum</AggregationFunction><AggregationFunction xsi:nil="true" /></ColumnAggregationFunctions></Annotation><ColorSet>false</ColorSet><Color><R>0</R><G>0</G><B>0</B><A>0</A></Color></InstanceProperty></Properties><ChartVisualizations><ChartVisualization Visible="true"><Type>Top</Type><ChartFieldWellDefinition><Category Name="Model" Visible="true" DataType="String" ModelQueryName="'Table1'[Model]"><Table ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" /></Category><SerializableTableColumn Name="Cars" Visible="true" DataType="Long" ModelQueryName="'Table1'[Cars]"><Table ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" /></SerializableTableColumn><CategoryValue>Ford</CategoryValue><Function>Sum</Function></ChartFieldWellDefinition><Id>1a268f53-c1bd-43be-a003-252909957508</Id></ChartVisualization><ChartVisualization Visible="true"><Type>Top</Type><ChartFieldWellDefinition><Category Name="Model" Visible="true" DataType="String" ModelQueryName="'Table1'[Model]"><Table ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" /></Category><SerializableTableColumn Name="Cars" Visible="true" DataType="Long" ModelQueryName="'Table1'[Cars]"><Table ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" /></SerializableTableColumn><CategoryValue>Toyta</CategoryValue><Function>Sum</Function></ChartFieldWellDefinition><Id>7026d600-99e5-4e31-9ce3-e666d74331f9</Id></ChartVisualization><ChartVisualization Visible="true"><Type>Top</Type><ChartFieldWellDefinition><Category Name="Model" Visible="true" DataType="String" ModelQueryName="'Table1'[Model]"><Table ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" /></Category><SerializableTableColumn Name="Cars" Visible="true" DataType="Long" ModelQueryName="'Table1'[Cars]"><Table ModelName="Table1" NameInSource="Table1" Visible="true" LastRefresh="0001-01-01T00:00:00" /></SerializableTableColumn><CategoryValue>Peugeot</CategoryValue><Function>Sum</Function></ChartFieldWellDefinition><Id>feff13e3-65c6-402e-a08e-6741cecc1a28</Id></ChartVisualization></ChartVisualizations><OpacityFactors><OpacityFactor>1</OpacityFactor><OpacityFactor>1</OpacityFactor><OpacityFactor>1</OpacityFactor><OpacityFactor>1</OpacityFactor></OpacityFactors><DataScales><DataScale>1</DataScale><DataScale>1</DataScale><DataScale>1</DataScale><DataScale>1</DataScale></DataScales><DimnScales><DimnScale>1</DimnScale><DimnScale>1</DimnScale><DimnScale>1</DimnScale><DimnScale>1</DimnScale></DimnScales></GeoVis></LayerDefinition></LayerDefinitions><Decorators><Decorator><X>584</X><Y>12</Y><DistanceToNearestCornerX>12</DistanceToNearestCornerX><DistanceToNearestCornerY>12</DistanceToNearestCornerY><ZOrder>0</ZOrder><Width>400</Width><Height>250</Height><ActualWidth>400</ActualWidth><ActualHeight>250</ActualHeight><IsVisible>true</IsVisible><SetFocusOnLoadView>false</SetFocusOnLoadView><Legend><LayerId>3f1c55e6-aee3-4d0e-b211-eb4903e561f2</LayerId><Minimum>350</Minimum><Maximum>650</Maximum></Legend><Dock>TopRight</Dock></Decorator><Decorator><X>298</X><Y>215.5</Y><DistanceToNearestCornerX>298</DistanceToNearestCornerX><DistanceToNearestCornerY>215.5</DistanceToNearestCornerY><ZOrder>1</ZOrder><Width>470</Width><Height>288</Height><ActualWidth>470</ActualWidth><ActualHeight>288</ActualHeight><IsVisible>true</IsVisible><SetFocusOnLoadView>false</SetFocusOnLoadView><Chart><Type>Top</Type><IsVisible>true</IsVisible><XYChartType>ColumnsClustered</XYChartType><IsClustered>true</IsClustered><IsBar>false</IsBar><LayerId>3f1c55e6-aee3-4d0e-b211-eb4903e561f2</LayerId><Id>1a268f53-c1bd-43be-a003-252909957508</Id></Chart><Dock>TopLeft</Dock></Decorator><Decorator><X>42</X><Y>240.5</Y><DistanceToNearestCornerX>42</DistanceToNearestCornerX><DistanceToNearestCornerY>107.5</DistanceToNearestCornerY><ZOrder>2</ZOrder><Width>792</Width><Height>333</Height><ActualWidth>792</ActualWidth><ActualHeight>333</ActualHeight><IsVisible>true</IsVisible><SetFocusOnLoadView>false</SetFocusOnLoadView><Chart><Type>Top</Type><IsVisible>true</IsVisible><XYChartType>ColumnsClustered</XYChartType><IsClustered>true</IsClustered><IsBar>false</IsBar><LayerId>3f1c55e6-aee3-4d0e-b211-eb4903e561f2</LayerId><Id>7026d600-99e5-4e31-9ce3-e666d74331f9</Id></Chart><Dock>BottomLeft</Dock></Decorator><Decorator><X>298</X><Y>215.5</Y><DistanceToNearestCornerX>298</DistanceToNearestCornerX><DistanceToNearestCornerY>215.5</DistanceToNearestCornerY><ZOrder>3</ZOrder><Width>578</Width><Height>426</Height><ActualWidth>578</ActualWidth><ActualHeight>426</ActualHeight><IsVisible>true</IsVisible><SetFocusOnLoadView>false</SetFocusOnLoadView><Chart><Type>Top</Type><IsVisible>true</IsVisible><XYChartType>ColumnsClustered</XYChartType><IsClustered>true</IsClustered><IsBar>false</IsBar><LayerId>3f1c55e6-aee3-4d0e-b211-eb4903e561f2</LayerId><Id>feff13e3-65c6-402e-a08e-6741cecc1a28</Id></Chart><Dock>TopLeft</Dock></Decorator></Decorators></SerializedLayerManager></LayersContent></Scene></Scenes></Tour>
<?xml version="1.0" encoding="UTF-16"?>
<Visualization xmlns="http://microsoft.data.visualization.Client.Excel/1.0" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema"><Tours><Tour MinXmlVer="1" XmlVer="1" TourId="ec60d2e0-507a-474e-9274-6cfa4a58f6f7" Id="{E2F97C41-C1C2-49B9-9FF4-4D1B3A9A3911}" Name="Tour 1"><Description>Some description for the tour goes here</Description><Image></Image></Tour></Tours><Colors><Color><R>1</R><G>0</G><B>0</B><A>1</A></Color><Color><R>0</R><G>1</G><B>0</B><A>1</A></Color><Color><R>0</R><G>0</G><B>1</B><A>1</A></Color><Color><R>1</R><G>1</G><B>0</B><A>1</A></Color><Color><R>1</R><G>0</G><B>1</B><A>1</A></Color><Color><R>0</R><G>1</G><B>1</B><A>1</A></Color><Color><R>1</R><G>1</G><B>1</B><A>1</A></Color><Color><R>1</R><G>1</G><B>1</B><A>1</A></Color><Color><R>1</R><G>1</G><B>1</B><A>1</A></Color><Color><R>1</R><G>1</G><B>1</B><A>1</A></Color><Color><R>1</R><G>1</G><B>1</B><A>1</A></Color><Color><R>1</R><G>1</G><B>1</B><A>1</A></Color><Color><R>1</R><G>1</G><B>1</B><A>1</A></Color><Color><R>1</R><G>1</G><B>1</B><A>1</A></Color><Color><R>1</R><G>1</G><B>1</B><A>1</A></Color><Color><R>1</R><G>1</G><B>1</B><A>1</A></Color></Colors></Visualization>
[bookmark: section_59bec98853be487fa153df22871283fb][bookmark: _Toc79583832]Security
[bookmark: section_5e89c0154c5940b2bd7af50a03ad2eec][bookmark: _Toc79583833]Security Considerations for Implementers
None.
[bookmark: section_3e37bf22d09d4ca68a4b34dfcc4b0f65][bookmark: _Toc79583834]Index of Security Fields
None.
[bookmark: section_79084491f540468f974a961581ff17d1][bookmark: _Toc79583835]Appendix A: Full XML Schemas
For ease of implementation, the following sections provide the full XML schemas for this file format.
	Schema name
	Section

	3-D Data Visualization Tour schema
	5.1

	Geo cache schema
	5.2

	Region polygon cache schema
	5.3

	Tour collection schema
	5.4

	Custom region schema
	5.5

	Custom map schema
	5.6



[bookmark: section_dc3ac28ea84f48378eb4aa020368e684][bookmark: _Toc79583836]http://microsoft.data.visualization.engine.tours/1.0 Schema
<xs:schema xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xs="http://www.w3.org/2001/XMLSchema" attributeFormDefault="unqualified" elementFormDefault="qualified" targetNamespace="http://microsoft.data.visualization.engine.tours/1.0" xmlns:tns="http://microsoft.data.visualization.engine.tours/1.0">
  <xsd:complexType name="CT_Camera">
    <xsd:sequence>
      <xsd:element name="Latitude" type="xsd:decimal"/>
      <xsd:element name="Longitude" type="xsd:decimal"/>
      <xsd:element name="Rotation" type="xsd:decimal"/>
      <xsd:element name="PivotAngle" type="xsd:decimal"/>
      <xsd:element name="Distance" type="xsd:decimal"/>
    </xsd:sequence>
  </xsd:complexType>
  <xsd:complexType name="CT_Frame">
    <xsd:sequence>
      <xsd:element name="Camera" type="tns:CT_Camera"/>
      <xsd:element name="Image" type="xsd:string"/>
    </xsd:sequence>
  </xsd:complexType>
  <xsd:complexType name="CT_Scene">
    <xsd:sequence>
      <xsd:element name="Transition" type="xsd:string"/>
      <xsd:element name="Effect" type="xsd:string"/>
      <xsd:element name="Theme" type="xsd:string"/>
      <xsd:element name="ThemeWithLabel" type="xsd:boolean"/>
      <xsd:element name="FlatModeEnabled" type="xsd:boolean"/>
      <xsd:element name="Duration" type="xsd:unsignedInt"/>
      <xsd:element name="TransitionDuration" type="xsd:unsignedInt"/>
      <xsd:element name="Speed" type="xsd:decimal"/>
      <xsd:element name="Frame" type="tns:CT_Frame"/>
      <xsd:element name="LayersContent" type="xsd:string"/>
    </xsd:sequence>
  </xsd:complexType>
  <xsd:complexType name="CT_Scenes">
    <xsd:sequence>
      <xsd:element maxOccurs="unbounded" name="Scene" type="tns:CT_Scene"/>
    </xsd:sequence>
  </xsd:complexType>
  <xsd:complexType name="CT_Tour">
    <xsd:sequence>
      <xsd:element name="Scenes" type="tns:CT_Scenes"/>
    </xsd:sequence>
    <xsd:attribute name="Name" type="xsd:string" use="required"/>
    <xsd:attribute name="Description" type="xsd:string" use="required"/>
  </xsd:complexType>
  <xsd:element name="Tour" type="tns:CT_Tour"/>
</xs:schema>
[bookmark: section_9bad59b2b2bf4bda8afd0d793466f88a][bookmark: _Toc79583837]http://microsoft.data.visualization.Client.Excel.LState/1.0 Schema
<xs:schema xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xs="http://www.w3.org/2001/XMLSchema" attributeFormDefault="unqualified" elementFormDefault="qualified" targetNamespace="http://microsoft.data.visualization.Client.Excel.LState/1.0" xmlns:tns="http://microsoft.data.visualization.Client.Excel.LState/1.0">
  <xsd:complexType name="CT_VisualizationLState">
    <xsd:sequence>
      <xsd:element name="cg" type="xsd:string"/>
    </xsd:sequence>
  </xsd:complexType>
  <xsd:element name="VisualizationLState" type="tns:CT_VisualizationLState"/>
</xs:schema>
[bookmark: section_65018bdac32b41e2a6ee4d09d9f82b89][bookmark: _Toc79583838]http://microsoft.data.visualization.Client.Excel.PState/1.0 Schema
<xs:schema xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xs="http://www.w3.org/2001/XMLSchema" attributeFormDefault="unqualified" elementFormDefault="qualified" targetNamespace="http://microsoft.data.visualization.Client.Excel.PState/1.0" xmlns:tns="http://microsoft.data.visualization.Client.Excel.PState/1.0">
  <xsd:complexType name="CT_VisualizationPState">
    <xsd:sequence>
      <xsd:element name="rp" type="xsd:string"/>
    </xsd:sequence>
  </xsd:complexType>
  <xsd:element name="VisualizationPState" type="tns:CT_VisualizationPState"/>
</xs:schema>
[bookmark: section_d24d0c8e435d48d09562da196f9975bb][bookmark: _Toc79583839]http://microsoft.data.visualization.Client.Excel/1.0 Schema
<xs:schema xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xs="http://www.w3.org/2001/XMLSchema" attributeFormDefault="unqualified" elementFormDefault="qualified" targetNamespace="http://microsoft.data.visualization.Client.Excel/1.0" xmlns:tns="http://microsoft.data.visualization.Client.Excel/1.0">
  <xsd:complexType name="CT_Tour">
    <xsd:sequence>
      <xsd:element name="Description" type="xsd:string"/>
      <xsd:element name="Image" type="xsd:string"/>
    </xsd:sequence>
    <xsd:attribute name="Name" type="xsd:string" use="required"/>
    <xsd:attribute name="Id" type="xsd:string" use="required"/>
    <xsd:attribute name="TourId" type="xsd:string" use="required"/>
    <xsd:attribute name="XmlVer" type="xsd:unsignedByte" use="required"/>
    <xsd:attribute name="MinXmlVer" type="xsd:unsignedByte" use="required"/>
  </xsd:complexType>
  <xsd:complexType name="CT_Tours">
    <xsd:sequence>
      <xsd:element maxOccurs="unbounded" name="Tour" type="tns:CT_Tour"/>
    </xsd:sequence>
  </xsd:complexType>
  <xsd:complexType name="CT_Visualization">
    <xsd:sequence>
      <xsd:element name="Tours" type="tns:CT_Tours"/>
      <xsd:element name="Colors"/>
    </xsd:sequence>
  </xsd:complexType>
  <xsd:element name="Visualization" type="tns:CT_Visualization"/>
</xs:schema>
[bookmark: section_67a046450e4c40d2add1c26c14ed4805][bookmark: _Toc79583840]http://microsoft.data.visualization.Client.Excel.CustomRegionState/1.0 Schema
<xs:schema xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xs="http://www.w3.org/2001/XMLSchema" attributeFormDefault="unqualified" elementFormDefault="qualified" targetNamespace="http://microsoft.data.visualization.Client.Excel.CustomRegionState/1.0" xmlns:tns="http://microsoft.data.visualization.Client.Excel.CustomRegionState/1.0">
  <xsd:complexType name="CT_CustomRegionState">
    <xsd:sequence>
      <xsd:element name="rl" type="xsd:string"/>
    </xsd:sequence>
  </xsd:complexType>
  <xsd:element name="CustomRegionState" type="tns:CT_CustomRegionState"/>
</xs:schema>
[bookmark: section_b6786e17b444443d85be473cd3ea2c37][bookmark: _Toc79583841]http://microsoft.data.visualization.Client.Excel.CustomMapList/1.0 Schema
<xs:schema xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xs="http://www.w3.org/2001/XMLSchema" attributeFormDefault="unqualified" elementFormDefault="qualified" targetNamespace="http://microsoft.data.visualization.Client.Excel.CustomMapList/1.0" xmlns:tns="http://microsoft.data.visualization.Client.Excel.CustomMapList/1.0">
  <xsd:complexType name="CT_CustomMapList">
    <xsd:sequence>
      <xsd:element name="ml" type="xsd:string"/>
    </xsd:sequence>
  </xsd:complexType>
  <xsd:element name="CustomMapList" type="tns:CT_CustomMapList"/>
</xs:schema>
[bookmark: section_7ebcf732c85541e089f98ee2290d9c8b][bookmark: _Toc79583842]Appendix B: Product Behavior
The information in this specification is applicable to the following Microsoft products or supplemental software. References to product versions include updates to those products.
· Microsoft Office 2016
· Microsoft Office 2019
· Microsoft Office 2021
Exceptions, if any, are noted in this section. If an update version, service pack or Knowledge Base (KB) number appears with a product name, the behavior changed in that update. The new behavior also applies to subsequent updates unless otherwise specified. If a product edition appears with the product version, behavior is different in that product edition.
Unless otherwise specified, any statement of optional behavior in this specification that is prescribed using the terms "SHOULD" or "SHOULD NOT" implies product behavior in accordance with the SHOULD or SHOULD NOT prescription. Unless otherwise specified, the term "MAY" implies that the product does not follow the prescription.
[bookmark: section_ff3a295adc9c41d0b7cd40d8bffc205d][bookmark: _Toc79583843]Change Tracking
This section identifies changes that were made to this document since the last release. Changes are classified as Major, Minor, or None. 
The revision class Major means that the technical content in the document was significantly revised. Major changes affect protocol interoperability or implementation. Examples of major changes are:
· A document revision that incorporates changes to interoperability requirements.
· A document revision that captures changes to protocol functionality.
The revision class Minor means that the meaning of the technical content was clarified. Minor changes do not affect protocol interoperability or implementation. Examples of minor changes are updates to clarify ambiguity at the sentence, paragraph, or table level.
The revision class None means that no new technical changes were introduced. Minor editorial and formatting changes may have been made, but the relevant technical content is identical to the last released version.
The changes made to this document are listed in the following table. For more information, please contact dochelp@microsoft.com.
	Section
	Description
	Revision class

	6 Appendix B: Product Behavior
	Updated list of supported products.
	major
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